RESEARCH ON PLANT LAYOUT AND PRODUCTION LINE RUNNING SIMULATION IN PISTON FACTORY USING ‘ARENA’

1ROHAN VERMA, 2IMTIYAZ KHAN, 3MANAS KUMAR GHOSH

1M.Tech Scholar, IE&E&M, Mech. Eng. Dept., Mandsaur Institute of Technology, Mandsaur 458001, MP,
2Senior Lecturer, Mech. Eng. Dept. Mandsaur Institute of Technology, Mandsaur 458001, MP
3Prof., Mech. Eng. Dept. Mandsaur Institute of Technology, Mandsaur 458001, MP

ABSTRACT

The aim of this paper is to create a better understanding of how simulation is used in industry especially in the area of facility layout planning. The project in which this paper is based upon concerns the development of a factory layout which will be created in a production line simulation. Background research was conducted in the field of simulations including the history, advantages, current capabilities, steps of development, and current uses. Research also concerning layout planning will also be reported in the research sections of this paper. The layout planning and simulation of a production line for a piston will be followed to prove the benefits of simulation in facility layout planning. The paper will follow the steps taken by the Engineering team to construct the layout used in the simulation as well as touch upon the actual construction of the simulation. The results will be used to further develop the facility

1. layout as well as help other colleagues visualize and understand the production system.

1. INTRODUCTION

Plant Simulation for modeling, simulating, analyzing, visualizing and optimizing production systems and processes, the flow of materials and logistic operations. Using Tecnomatix Plant Simulation, users can optimize material flow, resource utilization and logistics for all levels of plant planning from global production facilities, through local plants, to specific lines. Within the Plant Design and Optimization Solution the software portfolio, to which Plant Simulation belongs, is together with the products of the Digital Factory and of Digital Manufacturing part of the Product Lifecycle Management Software (PLM). The application allows comparing complex production
alternatives, including the immanent process logic, by means of computer simulations. Plant Simulation is used by individual production planners as well as by multi-national enterprises, primarily to strategically plan layout, control logic and dimensions of large, complex production investments. It is one of the major products that dominate that market space.

2. PRODUCT DESIGN

Product design deals with the conversion of ideas into reality and other forms of human activity, aims at fulfilling human needs. A designer does not usually produce the goods or services which immediately satisfy consumer’s needs. Rather, he produces the prototype which is used as a sample for reproducing the particular goods and services as many times as required. A design may be of a pattern on upholstery or of a dress in the world of fashion. It has two aspects:

1. Design by Evolution: In past, design is used to evolve over a long span of time. It reduced risks to making major errors. This was design by evolution. Example: Development of bicycle from its crank operated version to its present day chain and sprocket version over a period of about a century.

2. Design by Innovation: Every skill which the designer or a design team can muster in analysis and synthesis is instrumental in a totally novel design. It is the application of new solutions that meet new requirements, inarticulate needs, or existing market needs. This is accomplished through more effective products, processes, services, technologies, or ideas that are readily available to markets, governments and society. Example: Invention of laser beam and invention of solid state electronic device.

2.1 PRODUCTION SYSTEM

A production system is a collection of people, equipment, and procedures, organized to accomplish the manufacturing operations of a company or other organization. The production system which consists of facilities and manufacturing support systems Production systems can be divided into two categories: _ Facilities/ plant layout Manufacturing Support System.

![Production System Diagram](image)

Fig 2.1: The Production System consists of Facilities and Manufacturing Support Systems
2.2 PLANT LAYOUT

Plant layout is the optimum arrangement of man, machine, equipment, and materials. And it also showing the space allocated for material movement storage and activities from the conflict of raw materials to the shipping of the finished goods for an overall economy and efficiency of production. Fig.2.2 represents a simple plant layout. An industrial plant must compatible efficiently and economically. Its design must consider for the basic operating conditions to be served. The main objective of plant layout is to bring an orderly arrangement of departments and work centers to minimize the movement of material and allowing for sufficient working space for future expansion of plant. Plant layout affects both productivity and profitability of a company. Hence, it is as important as corporate decision. The cost of products and the supply/demand ratio are directly affected by plant layout. Hence cost of product and also supply/demand ratio will be optimum by optimum design of plant layout. Plant layout makes the arrangement of a company’s physical facilities conductive for the efficient and effective use of its equipment, material, people and energy. A good and effective plant layout minimizes the material handling effort and costs.

![Fig 2.2: A Simple Plant Layout](image)

2.3 MANUFACTURING SUPPORT SYSTEM

For making the production facilities efficiently, a company must have to organize itself to design the processes and equipment, plan and control the production orders, and satisfy product quality requirements. These functions are accomplished by manufacturing support systems. The manufacturing support system manufacturing support system involves:

1. Business Functions: The business functions are the principal means of communicating with the customer. It is the beginning and the end of the information-processing cycle. The order to produce a product typically originates from the customer and proceeds into the company through the sales and marketing department of the firm.
2. Product Design: If the product is to be manufactured in accordance to customer design, the design will have been provided by the customer. The manufacturer’s product design department will not be involved. If the product is to be produced to customer specifications, the manufacturer’s product design department may be contracted to do the design work for the product as well as to manufacture it.

3. Manufacturing Planning: The information and documentation that constitute the product design flows into the manufacturing planning function. The information-processing activities in manufacturing planning include process planning, master scheduling, requirements planning, and capacity planning. Process planning consists of determining the sequence of individual processing and assembly operations needed to produce the part. The manufacturing engineering and industrial engineering departments are responsible for planning the processes and related technical details.

4. Manufacturing Control: It includes logistics issues, commonly known as production planning. The master production schedule is a listing of the products to be made, when they are to be delivered, and in what quantities. Months are traditionally used to specify deliveries in the master schedule. Based on this schedule, the individual components and subassemblies that make up each product must be planned.

2.4 OBJECTIVES OF PLANT LAYOUT STUDY
1. Minimize investment in equipment.
2. Minimize overall production time.
3. Utilize existing space most efficiently.
4. Provide for employee convenience, safety and comfort.
5. Maintain flexibility of arrangement and operation.
6. Minimize material handling cost.
7. Minimize variation in types of material handling equipment.
8. Facilitate the manufacturing process.
9. Facilitate the organizational structure.
3. PROBLEM FORMULATION

The process and layout study in the company interprets the layout problems which results in the less production of pistons and also more number of piston rejection. The main problem observed here is this that they can produce pistons in casting cell may be about 400 piston/shift but in piston finishing cell they get the output of about 250 pistons/shift i.e. here input is high but output is low because of improper arrangements of machines. This directly affects the material flow and finally which results in less production rate.

3.1 PROBLEM FORMULATION

Problem Formulation Involves-

* Layout and material flow study.
* Process outline study.
* Work station study.
* The flow of materials study.
* Improving and revising existing layout.
* Evaluation for an effective layout.
* Complex production layout study.
4. PROPOSED METHODOLOGY

In an assembly line the product units move with a constant transportation speed through the consecutive stations. The total work content to be performed by the production system has been split up into economical indivisible work elements which are called tasks. Among the set of tasks there exist technological precedence relations. The set of tasks to be performed in the same station is called an operation or a station load. The time to perform an operation is restricted by the cycle time. The assembly line balancing problem consists in allocating the tasks to the stations subject to the technological precedence relations, the cycle time restriction of the stations and the indivisibility of the tasks. The objective of assembly line balancing is usually to minimize the number of stations in a line, minimize the total idle time of the total capacity provided by the sum of the stations of the line. Therefore, this is called time-oriented assembly line balancing.

4.1 METHODS FOR BALANCING ASSEMBLY LINES

1. Heuristic Layout Technique.
2. Simulation Layout Technique.

4.1.1 Heuristic Layout Technique:
1. Largest Candidate Rule.
2. Kilbridge and Wester Method.

4.1.2 Simulating Layout Technique
A number of computerized layout programs have been developed since the 1970s to help devise good process layouts. Of these, the most widely applied Programs are

1. Arena.
2. Tecnomatix plant simulation.
3. Witness.

4.2 ARENA
Arena is a simulation environment consisting of module templates, built around SIMAN language constructs and other facilities, and augmented by a visual front end. With Arena, you can:

- Model your processes to define, document, and communicate.
- Simulate the future performance of your system to understand complex relationships and identify opportunities for improvement.
- Visualize your operations with dynamic animation graphics.
- Analyze how your system will perform in its “as-is” configuration and under a myriad of possible “to-be” alternatives so that you can confidently choose the best way to run your business.
4.3 ARENA MODELING ENVIRONMENT

Arena modeling home screen is shown in fig. 4.1

4.4 CONTENTS IN ARENA HOME SCREEN

1. Menu Bar: The Arena Menu bar consists of a number of general menus—File, Edit, View, Window, and Help. Menu bar of arena home screen. It also has the following set of Arena-specific menus:

* The Tools menu provides access to simulation related tools and Arena parameters.
* The Arrange menu supports flowcharting and drawing operations.
* The Object menu supports module connections and sub-model creation.
* The Run menu provides simulation run control.

![Fig 4.1: Arena Home Screen](image1.png)

2. Project Bar, located on the left side of the Arena window and below the tool bars. The project bar contains three panels: the Basic Process panel, the Report panel, and the Navigate panel. Every panel contains several modules that are used in constructing simulation models. Project bar is shown in fig. 4.3

![Fig. 4.2: Menu Bar of Arena Home Screen](image2.png)
3. The Model Window Flowchart View: It is located on the right side of the Arena window and below the tool bars. This view is actually the workspace for the simulation model. It will contain all the model graphics: the flowchart, animation, and other drawings of the model.

4. The Model Window Spreadsheet View: located on the right-hand side and below the flowchart view. The spreadsheet view shows the model data.

5. Draw and View Bars: The Draw toolbar supports static drawing and coloring of Arena models. Draw bar is shown in fig. 4.4.
Fig. 4.4: Draw Bar of Arena Home Screen

Its buttons include Zoom In, Zoom Out, View All, and View Previous. These functions make it convenient to view large models at various levels of detail.

Fig. 4.5: View Bar of Arena Home Screen

5. DATA COLLECTION FROM COMPANY

Companies have 3 manufacturing cell and each manufacturing cell have sub production line, each perform a particular specific work. Here each manufacturing cell take input from sub production line These manufacturing cell are following:

- Casting of piston.
- Finishing of piston cell.
- Packing of piston and ring.

5.1 FLOW CHART OF PISTON FINISHING CELL

In B. Shankra Sales pistons are initially manufactured by casting. At the foundry we make pistons by casting. Then it comes to finishing piston cell. Then it goes to another cell where rings are fitted in these pistons. We are studying the middle cell i.e. finishing of piston cell. In this we smoothening the piston which comes from the foundry. Various machines are employed in this cell. Here we have the input of 400 pistons (raw material) and output of 240 pistons. Fig. 5.1 shows the flow chart of plant. It has eleven main machines grinding machine, lathe-1, lathe-2, lathe-3, lathe-4, lathe-5, lathe-6, lathe-7, boring machine, lathe-8, and then honing machine. After going to all machines piston goes on inspection section where inspection of piston and piston numbering is done.

5.2 SUB PRODUCTION LINE

Fig. 5.2 shows the flow diagram of Single Phase Sub Production Line Single phase sub production line consist of no. of manufacturing machines with cycle time, such as Grinding machine (M1) & cycle time is 0.40 min, Lathe machine-1 (M2) & cycle time is 1.20 min., Lathe machine-2 (M3) & cycle time is 0.50 min., Lathe machine-3 (M4) & cycle time is 1.10 min., Lathe machine-4 (M5) & cycle time is 1.00 min., Lathe machine-5 (M6) & cycle time is 1.20 min., Lathe machine-6 (M7) & cycle time is 1.40 min., Lathe machine-7 (M8) & cycle time is 0.50 min., Boring & Pin hole
machine (M9) & cycle time is 1.10 min., Lathe machine-8 (M10) & cycle time is 1.10 min., Honing machine (M11) & cycle time is 1.00 min. This production line takes input in the form of casting piston raw material and gives output in the form of finished piston for single phase assembly line.

**Fig 5.1: Flow Chart of Plant**

Production line takes input in the form of casting piston raw material and gives output in the form of finished piston for single phase assembly line.
6. CONCLUSION

Distance of workflow from the modified plant layout of their sections can be reduced. Not only improving workflow but also the accidents from objects which were not in order during material transportation can be decreased. Finally, Rearranging layout decreased distance and time consumption in flow of material and accidents, resulting in an increase in productivity. Plant Simulation for modeling, simulating, analyzing, visualizing and optimizing production systems and processes, the flow of materials and logistic operations. The application allows comparing complex production alternatives, including the immanent process logic, by means of computer simulations. Plant Simulation is used by individual production planners as well as by multi-national enterprises, primarily to strategically plan layout, control logic and dimensions of large, complex production investments. It is one of the major products that dominate that market space.

REFERENCES